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BEST PRACTICES COURSE – WEEK 17 – Complex Modeling PART 9- 
A- Morph Tool Basics 
 

Welcome everyone to the ArchiCAD Best Practices Course training lesson on the Morph tool basics. This 

is Eric Bobrow speaking to you from San Rafael, California. So the Morph tool was introduced into 

ArchiCAD 16. We are working in ArchiCAD 17 right now, and there may have been a few subtle changes 

between 16 and 17. If you have a version before 16, you can just watch and know that eventually when 

you upgrade, this will be available. If you have 16 or 17, then this is in your toolbox. [0:00:35] 

The Morph tool lives in the standard toolbox here. It's part of the 3D modeling tools. And it really is a 3D 

geometry maker. It is a general free form tool. What I mean by that is that it can do almost any shape. 

It's not specifically structural or ornamental, it could be either. It can be created from scratch; you can 

just draw something and make a form. You can also convert it into a morph where you can do more 

manipulation on it. It's a geometrically flexible tool, so you can have very complex shapes or simple 

ones. And the manipulations vary from the trivially easy to the extraordinarily complex options. 

[0:01:28] 

So it's a tool that we are going to approach the basics of today. I have scheduled a second lesson on 

Friday where we will go deeper and further. So when I activate the Morph tool, you will see that in the 

info box there are several geometry methods. There is an option to draw lines or edges, a boundary that 

would be a rotated box. This would be 2D boxes, rectangles, arcs, or circles. There is also an option to 

draw a box or a rotated or revolved form. Now you will also see that there is an option for what it's 

made of. This would have an impact only on the section. [0:02:25] 

You won't see it on the plan. And it will only be available or seen when the morph is solid. A morph can 

be a solid volume, a surface, or a series of surfaces that are essentially not closed or empty. It does not 

have the option for doing multiple skins like the Shell tool, or standard tools like walls and roofs and 

slabs. This is because it is so free form that all you can control is if it is solid, what is inside it; and when 

you have edges, you have some options for the surface appearance of these faces. [0:03:09] 

So how does it work? If I click the first geometry method, polygonal, I can do a series of lines. When I 

click the last point, we are done. It looks like just lines, but when I go to 3D, we'll see that these lines 

actually exist here. I have my editing plane right now set to an odd thing because I was working ahead of 

time. I will set it to - actually, there is a palette that I recommend that you open up when you are 

working with freeform elements. It's under Toolbars, Drafting Aids. So Drafting Aids is something I don’t 

regularly use, but is really important if you want to control things particularly with the Morph tool or 

more complex forms. [0:04:05] 
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It has a lot of shortcuts. You will see that some of them are in the standard options. So the grid tool here 

is on both of them; rulers and things like that. But one thing we can do is 'Return to Default Editing 

Plane' here; this is a quick way to put it. You can see the plane displayed here. And I can also turn on or 

off the editing plane display. These would also be available under the View menu. You can see 'Editing 

Plane Display' is available here. And under the View menu, there is 'Editing Plane Options' here. But this 

compact palette gives you quicker access to those things. [0:04:50] 

Now the main point here is that I just drew a series of lines, but this is showing up in 3D space. So just to 

give it some context, I will draw a simple wall here. We'll put in a door and a window, just so we can see 

these things in context. If I go to 3D, we can see this is just lying on the ground plane. When I go back to 

the Morph tool, we can also do a rectangle. So if I do a rectangle, it just creates four edges, as expected. 

If I go to 3D, you will see that these four edges exist and they have a surface. So unlike the simple edges, 

this is a closed surface. [0:05:42] 

If I go and do the rotated one, it will be what you would expect. It will also be closed in 3D here. And if I 

go to the arc ones, we can either do it by center and do a partial arc or a full one if we double click twice 

in the same point. If I go to 3D, we’ll see that the partial arc is not closed, but the full one is. So it 

automatically looks and sees if the starting point of your four edges or as many edges as you have are 

closed and then it fills it in. so if I go in here and select this, I can edit as you would expect with any 

polyline. [0:06:28] 

If I go here I can move this point. So that is moving the end point here. I can move this around. If I move 

it on top of the other one, it will snap. That is interesting. It didn't create the surface of that, but we can 

use the special command under the Design menu, Modify Morph, and we can say 'Cover with Faces'. It 

will ask if we want to do some sharp or smooth surfaces, I will choose sharp. And you can see how it 

closes that. So the edges can exist independently, or we can have the face added separately. If we were 

using some of the simple creation methods, it would create that for us. [0:07:19] 

Now going on to some more of the basics. If we go to the box method and we click a couple of points 

here, we will draw that rectangle similar to what we had. Then it will ask for an extrusion length. 

Basically, how thick or tall is the box? The default is set to be 1 meter, which is why it gives us this odd 

value in U.S. measurements, 3 feet and 3/8 inches. I will say 4', and it will go 4' up. Now, negative values 

will create a vector extending away from you. So since we are drawing this with its base at zero, that is 

something we can choose on the floor plan, where our elements are. [0:08:05] 

In 3D, we can also snap to things, so we will look at that. But this extrusion length is something that 

comes up when you are working on the floor plan to say how tall it is or possibly how far down does it 

go from wherever you start. So I will just say 4'. Now when I go to 3D, we are going to see that here is a 

piece of concrete. Now the final one is this rotated or revolved form. And this gives you an option for 

creating a shape. Now you will notice when I am clicking these things that there is the pet palette for the 
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polyline options. If I wanted to create a shape - that's tangential. Interesting, so that is the first two 

points and this is the third. So let me - this is slightly different than what I was expecting. We don’t have 

the three point method here, so I can't define the second and third point. I am going to back up a step. 

This is something that most people know. If I hit the Delete key, it backs up a single step. [0:09:28] 

So now I can go and say I would like to have this down to here, and then curve it after the fact. And now 

let me take the straight segment over to this point. And I will click one more time to finish. So I have 

defined a polyline in space. Now the prompt says, 'Enter the first point of the revolution axis.' So I can 

say I would like to revolve this around this point. We have a checkmark, but this is odd. The bottom tip 

of the revolved cursor is what it's paying attention to. When I bring it close to that point, it's snapping, 

and the checkmark shows up, but I would think that if I were putting it at the center of this that's where 

it would snap, but it’s actually the little tip that it's looking at. [0:10:20] 

Then I can draw a second line. This is like a mirroring axis, if you think about how we are mirroring it. 

You can imagine this would be sort of a vase shape. Now the revolution angle is 180˚, and you can do it 

positive or negative. Let's leave the 180˚ here, and let's see what it does. So you can see how it created 

something sort of interesting on the plan. If I go to 3D we'll see the shape, which went underneath the 

viewing plane. And it drew it going below. So the 180˚ went around in this orientation. I guess if the 

center point is this point right here, it went around counter clockwise. [0:11:18] 

This is the way that ArchiCAD measures angles. Now one of the cool things that you can do in the Morph 

is you can rotate this freely in space. So I will go to the center point and say I want to rotate it here. This 

is true of many of the tools that ArchiCAD offers, such as the Shell tool and the Curtain Wall tool. When I 

rotate it, you can see the compass. If I click arbitrarily in space, the editing plane is what is taking effect. 

Now I am rotating this simply on the plan. If I go back to the floor plan, you can see how I have rotated it 

there. [0:12:07] 

Now if I go back and say that I want to rotate this and instead of going in free space, I go to an edge, it 

will find the perpendicular to it. This edge allows me to say I would like to rotate this and stand it up. 

Now you can see that the plane display has changed. The snaps for X and Y are then easily understood. 

And you can see how that stands up. Now this is a rather odd shape to have so big here, so I am going to 

delete it. But you get the idea that we can draw something of a certain complexity, and then move it 

around in a way that is much more flexible than other elements. [0:12:48] 

Now let's look at some basic editing operations that we have for the Morph tool. We have just created a 

few shapes here. If I go to this one here and select it and hover over it, you will notice that there is a 

surface snap shadow there. This is turned on or off with this icon here. With the morph, there is a 

separate icon that indicates we are on a surface, and we can edit it. You will see there are some editing 

options that we can work with. Let's escape out of this and turn this back on. The same thing is possible; 

it just had that larger icon for the surface snap. [0:13:41] 
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Now as I move this around, it allows me to extrude this simple surface in either direction. And it 

automatically knows to do it perpendicular to the surface. So it follows what is called the 'normal'. So we 

can type in a distance. If I wanted it to be 2' high, I could type in 2. And now it's exactly 2' up. Now that 

operation that I just did is the one that is a simple push or pull; it's very similar to Sketch Up. So if you 

have worked with Sketch Up at all, you will find that very natural. [0:14:28] 

If I go to this edge, I can pull this out. And you can see that after it's complete - just for a second - as I do 

this, you can see the original line. Then when I let go or click again, it will remove that line. It just 

extends all of these surfaces. Now I will make a more intricate shape. Let me draw something as an 

example. I will take an object, and we'll look at how you can create something from other elements. I 

am going to the Object tool, and I'm going to get a molding shape here. [0:15:11] 

So we'll go to the Detailer Library. This is available in the U.S. version. I don’t think they have the 

equivalent in the international library. You could certainly import these sorts of 2D elements. Let's go 

and show this. So you can see this is a shape here. Let's go to a corner one or a code molding here. That 

will be the most interesting and simple to work with. So this is a 2D element. You can see I am looking at 

the 2D. There is no 3D in this object. I am going to use this to place a graphic here. I will drop this in. it's 

very tiny relative to the other elements. [0:16:07] 

Now when I select this, it is an object. So all I can do is move it around or resize it. It's only 2D. I am going 

to go to Reshape, Explode to Current View. This allows me to convert into the basic linework. I don't 

need to keep the original elements, so I will just go to the drawing primitives. That will leave me just the 

lines and fills. Now having done that, I can get rid of the linework that indicated what it was made of. 

Now I have just arcs and lines. There looks to be an extra piece I missed here. [0:16:47] 

Now I can go with the fill tool for example, and magic wand this. Let me change the Fill tool to 

Percentage and magic wand that. You can see how this is just a fill. So if you are not familiar and do not 

know what I just did, basically I held down the Space bar to get the magic wand, and I have the Fill tool 

active. I am going within an enclosed area and clicking. That is creating a 2D volume. Now instead of 

doing that, what I will do is go to the Morph tool and hold down the space bar and click. [0:17:28] 

 Now you can see that the area got surrounded. Now because I have this set for revolution axis, it's a 

revolved element. It's waiting for me to revolve it. Let me return to that in a minute. Let's go back to 

creating a surface element here. So if I magic wand this and go to 3D, you can see this is a little hard to 

zoom in on. This is a morph, obviously. And this element here can be extruded just like before. So if I 

extrude this, I can take it up a certain distance. [0:18:18] 

Let's actually just drag it into proximity to the wall. So I am going to drag this here. And in fact, let me - 

just to make it easier - go back to the floor plan. This is the original object; these are the lines and arcs. 

And remember I dragged the morph over to here. Here is an interesting thing. I can take this and do a 
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marquee area and say 'Show this in 3D'. So I now have this little morph element here. And you know 

how I can go and extrude this up or down with the simple one? I can also use what is called a 'Tube 

Extrusion'. If I take this up and move it around, you can see how it's flipping some really odd geometry. 

That is out of the viewing plane. Remember, I have a marquee, so part of it is inside and part of it is 

outside. [0:19:36] 

That is what happened there. But with the tube option, it will fold this over on itself and turn it into a 

shape. Let's take this up instead over the top of the wall. So I will select it and go to the corner and use 

the Tube option here and we'll go up to the top. I am just trying to get up here and take it then 

potentially along the top and stop it. Now what you can see is that it very quickly created a very 

beautiful molded shape. Now it might need to be in a different orientation, depending upon what you 

are trying to do, but you can see how powerful it is. [0:20:28] 

This is a single morph element that I have just created. So that tube option allows you to take any profile 

and do that. If we go and say 'Show All in 3D', I will show you that we can take any shape, even if it's 

already solid. Remember, I just did that with a flat surface. But here is that tube option. I can take it up 

and over and do a few different shapes. So there is some duct work, we could imagine. It's large, but you 

get the idea of how flexible that is. [0:21:14] 

Now let's take a look at how we can sub divide surfaces and start to do more complex modeling directly 

on this. If I select this and we go to the center here, let's look at the rest of the editing options here in 

this top row. I have looked at the one that extends the current face. This one that is a tube. Here is one 

that makes a bulge or indentation. When I do this, it takes whatever point I clicked on and it makes that 

the center of the deformation. Then I can type in a value or indicate visually how far I want the effect to 

extend. This is how far the bump or indentation will extend. [0:22:04] 

Then I can go and type in or visually create the shape. Now let me do this again and let's take that out 

further. Now you can see I can take this out so it affects the entire surface. So I made the radius of this 

go further. Now you can see it's somewhat bumpy. This can be smoothed later with some of the 

smoothing options for that, but for now, let me continue on with some of the basic editing. This is an 

option here that allows me to indent or extend the entire edge. You can see I was on a particular 

surface. It found the boundaries of that surface and now I can potentially extend this in a particular 

distance, let's say 1'. [0:23:11] 

I now very quickly have a clean shape. The base had a certain size; the top was the same size. Then I 

took this in a specific distance. That is an option there. Now I am going to show you how we can actually 

add a new surface to this. If I take this and while I am doing this I press and release the Option key on 

the Mac or the Ctrl key on Windows, then I actually have a plus sign right next to the little pencil. It's a 

little hard to see. Now, instead of showing the morph changing its top boundary, it's creating a new line. 

I will just do this freeform here. [0:23:56] 
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You will notice that the outside didn't change, but we now have this inner line that is green. Guess 

what? I can go here and extend this using the push and pull and perhaps take this up. Very quickly I can 

break up that surface into pieces and work with it individually. Of course then I can go here and take this 

surface and snap to this here. Now I have it indented on three sides, but these two faces are a plane. 

Now the edges here are actually very flexible in the sense that I can add new edges individually. I can 

also take them away. [0:24:40] 

If I select this and go to an edge, there will be an option to draw a new line. I can draw the line from 

here over to this other side. You can see the perpendicular snap. It is now drawn a new line. That means 

that I can go and extend this up. You see how this face is now just naturally extended up. I am actually 

building a little staircase the long way around, but I can create shapes freely here. Now I just drew a line. 

We want to in this case unify this so it's all one surface. How would we do that? I can switch my Arrow 

tool from the normal method that we have had in ArchiCAD since the beginning to a new one that was 

introduced with the Morph tool called a 'Sub item Selection'. [0:25:46] 

When I am in sub item selection, you will notice that the arrow has a while or hollow form. If I clicked on 

anything else, it has a little red circle with a line through it, it will say, 'This element type does not have 

any selectable faces or edges, please click on a morph.'  So instead, I go onto this morph and click on this 

edge. While the morph highlights, similar to what we had, the one edge is highlighted more than the 

others. I can delete this edge just by hitting the Delete key like normal. And now this surface is unified. If 

I click on a surface instead, it highlights that surface. [0:26:37] 

I can select a surface and I can delete it. You can see now we have a hollow shape. Let me undo that. I 

can also potentially change the material or surface appearance. Here we have our surface appearance. 

In ArchiCAD 16 this would be called the 'Material'. Now it's the 'surface' of the element. By clicking on 

this, I can say I would like to override this surface with a particular color or texture. Let me make this 

green. We can see now that this is a green surface and the other parts look like concrete. We can 

imagine this is painted. [0:27:23] 

Now I can select more than one of these. I can select several surfaces here. When I do that it indicates 

here that there are three surfaces selected. I can override them and maybe make them something else. 

So I have made them an ice surface. That made them translucent. So just like you can make glass, you 

can use other surfaces here. If I rotate around this, it's showing the inside of the morph. It's inaccurate 

in the sense that this back surface is opaque, and yet, we are seeing through it. In fact, here we are 

seeing through to the other side. [0:28:12] 

It affects our visibility through here. Then the back plane is ignored. So that's not realistic, but it does 

give you some interesting options for showing geometry that you might want to explore. Now when I 

am in this Arrow tool here, we can see the visual indication. If I click on anything else like the window, it 

will say that I can't select it because I am in this mode. So I would need to switch back to the regular 



 
 

  Best Practices Course – Week 17 Part 9-A – © copyright 2014 by Eric Bobrow 
 
 

selection to be able to select a window or any other standard element. Now if I go to the face here, it 

will select the morph as a whole. Now with the morph as a whole, I could go in and say that I want to 

make all of the surfaces a particular type. [0:29:07] 

Let's make them painted. This then gives me the option of affecting all custom faces; remember, I made 

these custom. Or I can apply it to all the custom ones as well. So you can see how we can quickly 

override that. The other possibility that we might want to do is say we don't want to override it. Click on 

this to turn it back to the natural surface appearance that comes from the building material. So this is 

the concrete. Now if I were to make this wood sheathing, plywood siding or something like that, it 

would have a different appearance here. [0:29:55] 

So far what we have looked at is the basic geometry for creating morphs from scratch and editing them 

by creating new surfaces or edges and possibly selecting or deleting edges or modifying some of these 

surfaces to override it. I see a question from Robert W. saying, "Eric, can you briefly discuss the pros and 

cons of using morphs for things like moldings vs. complex profiles? I am finding now that I am using 

both." [0:30:48] 

So let's talk a little bit about this. If we look at this morph shape here, I can edit it in a variety of ways. 

You saw how I can select edges and move them around. So we can create this and edit it very flexibly, 

but there is no profile that I can edit that would affect the entire morph. While it allows me to do a 

tubular extrusion of a shape, once I have created it, it's not editable as a profile. So if we were to use the 

Complex Profile tool, we could select the element and switch it from one profile to another. That is one 

key difference is that profiles and shells have a control, because they are constrained to be regular 

shapes, whereas morphs, while they can start out being regular, after you draw any particular piece, 

your controls are based on what geometry is there. [0:32:04] 

I think if you want to be able to try out different moldings, use the Profile tool. If you want to be able to 

create things on the fly and wrap them around in 3D space like I did, you may want to use the Morph 

tool. The Morph tool is more flexible, the Profile and the Shell tool are more regular. Now let's look at a 

few more manipulations that could be useful in this simple context. You can start to look at how you can 

convert elements to morphs to get those options. I will select this morph here and go to the edge here. 

We have looked at extrusions, we've looked at tubular, we've looked at this bulging thing, and we have 

looked at the offset edge. [0:32:51] 

We also looked at the one that is in pencil, which allows us to draw new edges on there. There is also 

this one here that is the custom face. This allows us to put a surface texture on it here. There are some 

different options for how the texture is applied. I am not going to get into this much; this is essentially 

the same thing as what I did before. I can say I want to make this custom and make it purple and say OK. 

It says we can do it on clicked faces, similar faces or all faces. Let's just say 'Clicked face' first. You can 

see what that did here. [0:33:32] 
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Let me go and do the same thing and say 'All similar faces'. What if we were to change this to a different 

color? What is 'All similar faces'? It only did the one face. Here is a shortcut that is important to know. 

Instead of going back up here, which is a nuisance - certainly, you can do it, but if you want to do it on 

the fly, there is a special shortcut that Graphisoft specifically introduced with the Morph tool. Let's say I 

am in the Morph tool. If I press the Shift key, I get an arrow. [0:34:20] 

The Shift key switches me to selection mode. If I hold down the Shift key and the Ctrl key, you notice 

how the arrow switches to that hollow shape. This is true regardless of what tool I am in. so Shift+Ctrl 

will give me that option. Even if I am in the Arrow tool, Shift+Ctrl will switch me to that option. So now I 

can select this face and these other ones. I can press down and say I want to do a custom edge here. 

Let's make it yellow. And this says, 'Apply changes to clicked face'. Actually, because I have several 

selected, it looks like it's going to automatically apply to all of them. Yes, it did. [0:35:04] 

So I am not quite sure about the 'All similar edges'. That is something that I will have to look up to see 

what the controls there. In any event, let me undo back to here. Let's look at some other options that 

we can do for the geometry. If I select this and go to the edge, there are options for me to draw another 

line across here. If I go to this edge here, there are options for me to curve it. If I rotate this around - it's 

not giving me controls. Let me just try this on the ground plane one, and I will say 'Curve'. [0:35:53] 

So this is going to be an interesting curvature. You can see the plane it is doing; it's doing the vertical 

plane. Sometimes it's good to rotate around. By the way, if you are not clear on how I am orbiting 

around or rotating around right on the fly, I am pressing down the center mouse button to get the pan, 

which allows me to go sideways or up and down; then adding the Shift key to get the Orbit. Then I can 

rotate around to get things in a different orientation right on the fly while I am in the middle of this. 

[0:36:25] 

You can see what that did is extended this face down. We have this odd underside. Let me undo that. 

Suppose I wanted to take this face out and control it so it was going along this plane. What I am going to 

do is use the option here to pick a plane for editing. Now if I go to any surface, you can see how it 

highlights that surface. If I click on this surface, it's going to lock in the editing plane for the duration of 

the next operation. You can see how it's vertical now. So now if I go along here and do the curved thing, 

I can easily make this particular edge come out. [0:37:14] 

Now if I measure this and type in that I want it to be 1' radius, that will be measured along here. Let's 

verify that. If I say measure from here to this point, there you can see it's 1'. I was able to pull it 

freeform, but type in a value. I go to the other side here and pick a plane from this side. Now I will go 

here and curve it the same way by typing in 1'. It looks odd here. This surface, while the two edges are 

curved in a similar way, ArchiCAD got confused with this surface. It's trying to connect in a way that is 

rather odd. [0:38:04] 
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So what I want to do is actually remove this surface and have ArchiCAD cover it again. I can select 

surfaces or edges by using Shift+Ctrl. By the way, that is the Ctrl key on both Mac and Windows. Unlike 

many other things where the Ctrl on Windows becomes Command on the Mac, like Ctrl+S is save and 

Command+S is save, in this case, Shift+Ctrl on either Mac or Windows will allow me to select one or 

multiple faces or edges. [0:38:36] 

Now I'm going to delete this, and you can see I have a hollow form. I am now going to select the four 

edges using Shift+Ctrl to get my sub item selection. I am going to get this edge, this curved one, this 

underside one, and this other one here. Now I have all four. There is an option under the Design menu, 

Modify Morph, Cover with Faces. Now if you have a closed boundary like this, it will do a great job. If 

you select a whole bunch of stuff, it will do the best it can. Sometimes it will cover things nicely the way 

you expect, sometimes it may get confused. [0:39:16] 

Here it should do pretty well. When I say 'Cover with Faces', do I want it to be sharp or smooth? In this 

case sharp, because I want it to literally slice at the edges rather than smooth at the edges. You can see 

how it has now created this little bulldozer sort of thing. Now think about it. This allows me to take 

something that otherwise was a simple shape and add a bull nose, add a fillet to it. Now how would we 

add a fillet to it? I haven't done this before, so let's just see. If I Shift+Ctrl these two and then go to this 

edge - this is interesting. What option does this say this is? [0:40:02] 

It is 'fillet or 'chamfered corners'. Okay, let's try that. Let's do 6" here. Interesting, look at what it did 

there. Now let's undo that. And what happens if we select all of these edges here and go to this and do 

the fillet chamfer. It still did that. Let's try this one, same option here. So that is an interesting shape. If 

you wanted to take the rough edge off. This gets into a little more complex editing. But I think we have 

learned enough that we can actually clean this up. So what would I do? I wanted to make this a simple 

rolled edge here. It might not be perfect for a stair, but let's say we wanted to do that. [0:41:07] 

I can delete this edge, this face and this face. So I can select all of these different faces here, and let’s 

zoom in and select this. Now I have just selected all of this face and the connecting points and deleted it. 

And it looks like I now have the edges, but I also have these extra pieces here. So I need to get rid of 

these little edges here. There's going to be another one there. Let's see if there is something else. There 

are a bunch of little pieces here, but now I have the straight edges. I might have done better if I would 

have deleted this before I did the fillet at the corner. [0:42:10] 

But now I can go and select these edges here and do the cover with faces. Now we have a nice, clean 

edge there. Let's see if we can get rid of this edge in between. If I select this and delete it, that actually 

got rid of that surface. So here's a bit more of an advanced part. We've been learning the basics of 

creating and editing. Now there's something that we haven't talked about which is, is this edge 

supposed to be seen? If I select that edge and go into the settings here, this is the Morph settings, but I 

have an edge selected. [0:43:07] 
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I can go here and say I would like it to be 'hidden' or 'soft'. So there is a subtle difference here. Let's try 

'hidden'. You can see how it disappears from view. So I can go into this and try this one. And I could have 

done both of them at the same time. Let's try 'soft'. Now if I rotate around this orbit, you can see this 

one is blended in, and this one, you can see a distinct difference on the surface. Let me go and select 

that edge. Can we select that edge? That edge is now hard to select, because it's hidden. [0:43:53] 

This is an option that in order to work with it, we need to go to the View menu, Onscreen View Options, 

and turn on 'Hidden Morph Geometry'. So this is a command you only need if you want to edit a morph 

in detail and some things are being hidden from you. So now if I do that you should be able to select 

this. You can see that it now allows me to select it. It indicates by its dotted appearance that it is hidden. 

I can go in here - can we change it? I am looking to see if there is a way to change it in the info box. 

Apparently not. [0:44:37] 

I can go here and say 'soft'. Now when I hit Esc, you will notice that it has this smooth surface. So 'soft' 

says, 'Hide the edge and blur adjacent surfaces', so we get a beautiful, rendered look. 'Hidden' would 

allow me to hide something - let me go here. We want this one to do the 'soft'. So now it would blend 

this around. There would be some times when you want to hide things, but soft is a better one in 

general there. [0:45:20] 

Now if I select this shape, you can see how it's selecting just the top surface. If I select here, it's selecting 

a piece. I can literally go and select these pieces. They are not very visible in our normal view, but 

because I have turned on the hidden morph geometry, they are now selectable, and I could do some 

editing for them. Normally what we want to be in is having hidden morph geometry turned off. Now if I 

select this, you will notice that it's selecting the entire surface. So if hidden morph geometry is turned 

off, then it selects what we see. If hidden morph geometry is turned on, then it may select little sub-

parts to give us finer control. [0:46:22] 

I have occasionally had hidden morph geometry turned on and realized that I couldn't select things the 

way I was used to. Then I realized after a bit of study that I needed to make sure that it was not turned 

on if I wanted to do more basic manipulation. Let's take a look at how we can convert an element to a 

morph. You will notice that this editing plane is vertical. I am going to go here and select 'Return to 

default editing plane'. That will put it horizontal here. [0:46:58] 

Now this editing plane is something that you can turn on or off in normal ArchiCAD, it has nothing to do 

with the Morph tool. The editing plane display can turn on or off here or in the View menu. You can see 

by having this turned off, it's more natural. Of course I don't have a ground plane, but it does help 

particularly if you are doing complex modeling to turn that on. If I do have it on, there are controls under 

the View menu. If we go to Grid and Editing Plane Options, we can go to Grids and Background. You will 

see that the editing plane in 3D has some options for the grid line backgrounds and the grid line. 

[0:47:46] 



 
 

  Best Practices Course – Week 17 Part 9-A – © copyright 2014 by Eric Bobrow 
 
 

If I double click on this color chip, I can give it a color if I want. I can make the background a little 

stronger. You can see I can make this more visual if I make the gridlines darker. Now this is going to have 

a little different appearance. If I say OK, you can see how that stands out much more. I think that 

Graphisoft changed the defaults of this in ArchiCAD 17 or at least in the U.S. template here to make it 

more subtle, because people were complaining that it was annoying. [0:48:27] 

Let me go back and change the grids and background to something like what we had before, sort of a 

neutral gray and a light gray color here. The gridlines also a lighter color to make it barely visible. So you 

can see that it's what it looks like there. So what are some of the other things that we can do with the 

Morph tool? I see some comments from the last few minutes, so let me see if I can answer any of these. 

Dave Norman wrote, "This tool would be great for quick massing model studies. Can we draw windows 

in the surface of the morph and then change the surface of the window so it is visible?" Yes, let's take a 

look at that. [0:49:09] 

Chris Sinkinson says, "Can you use it to say show a rendered finish on a wall?" Definitely. Let's see. Carol 

Wiley says, "I was using the profile tool to create a concrete molding around a fireplace opening. I could 

not get the vertical sides to cleanly attach to the horizontal piece. Would making it with the Morph be 

easier?" Yes. I can demonstrate that. And William K., I haven't seen you on one of these calls, so 

welcome. I hope I pronounced your name properly. William writes, "Eric, how do I show this in the floor 

plan? For example, for a fireplace that cleans up correctly and doesn't show what is above or below?" 

[0:49:46] 

Good questions. Let me take those. William E. says, "If the Morph tool is used to create a complex roof 

shape, is there a way to then create other elements conforming to that shape such as rafters?" Okay, so 

that I think Bill that would be something that we can maybe look at next time, because I think that gets 

really into more advanced questions. Joe A. writes, "Make a ground plane instead of a mesh." So I am 

not quite sure what your question is. You can certainly draw a ground plane that is a real element with 

the Slab tool or the Mesh tool. [0:50:23] 

This is a visual guide for what your current editing operations are going to be using as opposed to a real 

plane. That's just a virtual plane. So let's look at those questions. Dave Norman says, "Quick massing 

model studies, can we draw windows in the surface of the morph and then change the surface so that it 

is visible?" let's take a look at that here. So I am going to go in and create a morph here. I will use the 

box method like this. With the box in 3D, instead of having to type in a value, we can just snap it. I can 

take it up to 10'. [0:51:09] 

Now can we draw on the surface and make it a pseudo window here? If I select the surface and then go 

to the rectangular create here and press down, there is an option to draw. Let me explain. This would 

pull the surface and then continue on to possibly make it two. This would bulge or indent the surface 

starting from the point I clicked on. This would inset or extend the boundaries uniformly. This one, with 
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the pencil, allows me to draw with whatever is my active tool up here in the geometry method. Now I 

could go and type in the size, maybe a 3x5' rectangle. Now I can select just one surface by Shift+Ctrl 

clicking, so hold down the Shift+Ctrl to get the sub item selection. Then I can go in here and override this 

and make it say 'Glass'. [0:52:30] 

It's a bit odd, because we're looking into the space. But yes, we could do that. If I wanted to do this 

again, I can multiply this as well. I could go and select this surface here and then drag this. I can drag this 

along and right click on it to drag a copy. Now that obviously duplicated the whole thing. If I select just 

the surface here and Command+D or Ctrl+D, now I am moving this along the surface. I press and release 

the Option or Ctrl key to say that I would like to create a new copy of this. [0:53:32] 

Now what it did was created a new boundary here. Can I eyedrop it? I am holding down the Option key, 

that gives me the eyedropper. I hover over the morph, and you can see that it allows me to eyedrop the 

morph or this part of the morph. Now it says to do face selection, I can hold Shift+Ctrl down, that allows 

me to select. If I eyedrop this here and use the inject, that actually was smart enough. So I eyedropped 

one and injected it into another. [0:54:25] 

This could certainly be part of a massing study if we wanted. I am not quite sure - I think we can 

multiply, creating multiple openings, and these things could be extended. If I select this edge and 

dragged this down, notice that the morph looks like it's going to be deformed. I am pulling it out and it's 

going to extend this here. If I am on the little axis line, the Z axis in this case, you can see that it's staying 

within that surface there. So you have to be very careful to do that. The other thing that we could do is 

move the editing plane on top of here. [0:55:20] 

Now if I do this and move it, even though the editing plane is like that, I still have to make sure that I am 

on an axis point there. I think there are some editing options that you may need to get used to. But I 

think that answers that primary question of could you use this as a massing modeling tool. For example, 

if we wanted to have a shape that had a top going up slanted, how would we do that? Let's go to the 

plane selection along here and select this edge. We will take this up, and you can see I can snap this up 

3' or some distance. Now we have a nice shape here. [0:56:21] 

Now we are going to get into some more complex editing operations next time, but I think that gives 

you a sense of how you can draw shapes and push and pull them freely. Chris Sinkinson writes, "Can you 

use it to show a rendered finish on a wall?" I don't see why not. I am not quite sure what you mean. If I 

were to select the face here and override it I could change it to a different material. Let's say we wanted 

to have a band of brick or different types of brick. I can select the morph, press down on the edge and 

say that I would like to draw a new line. [0:57:08] 

I will draw a new line here using the polygon. I can switch it right in the middle of the operation. Now I 

am just drawing a single line, and I can go perhaps to where - let's rotate this around. Maybe that is a 
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perpendicular line in space. Let's take our editing plane and undo that and take it back to the default so 

it's not getting confused there. I will take this and draw a line in the editing operation. There is the 

perpendicular. Let's draw another one. I will do it freeform here. Now I am putting a demarcation on the 

surface. [0:58:04] 

This allows me to select this edge and turn it into some contrasting color. Now we are starting to get 

something very interesting. We can draw on the face and get a material look. Let's take a look at what it 

looks like in the south elevation here. You can see that it is showing up very cleanly. That I think shows 

some of the potential. Okay, in terms of the concrete molding around a fireplace opening, let's just take 

a fireplace opening in a wall. Let’s go and create a piece of wall here. [0:59:01] 

I'm not quite sure if we are going to be - let's just put in an empty door. I am going to do something 

simple here where I put in an empty opening here. Let's make it wider, say 5' and up to 4' and the sill at 

zero and put that in. if I go to 3D I now have a wall with an opening that is sort of what you might have 

for a fireplace. You were doing a molding. Let's go back and take that shape here and drag it into 

position like this. If I take this, it's 2D information, arcs and lines. I will go to the Morph tool and magic 

wand and say I want to do a closed form, and I magic wand this. If we go to 3D, there is a shape. 

[1:00:16] 

This is a morph that is solid, although it's showing concrete. That's why it's not particularly prominent 

looking. Let's put it into a plywood. This is set for glass. I am not quite sure why, but the last thing I was 

working on was set to be glass. I am going to leave it zoomed in to show you the controls. I will go to the 

corner here and go to the tubular shape and then zoom out and snap it up here. I will go across and 

down and the click one more time to finish. Then you can see how we have created a very nice shape 

around there. [1:01:16] 

Let's say that we had something that had an arc shape up here. How would we do that? Let's leave that 

for our advanced editing. We are already at one hour for this training. That gives you a sense of how you 

can follow that geometry to create that. Let's see, in terms of the way that this looks on the plan - let's 

look at the plan here. This is a question from William C.  This shape right here is showing a pretty clean 

representation; a top down view of it. We have this extra linework - this is just lines that I used as the 

base. I will select in here all the lines and all the arcs and drag. [1:02:24] 

So I just did a nice shortcut. This is a great tip. I want to select just those 2D elements that were in here 

to be able to drag them away, and do a marquee around it so that it would focus the attention there. I 

then went to the Line tool and hit Command+A or Ctrl+A to select all the lines in the marquee. Then I 

went to the Arc tool and did the same thing. That added to the selection all of these things. So now I 

ended up with four elements of which four are lines and if we go to the - so that selected all of those 

there. [1:03:02] 
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Now an option here that sometimes you may want to do is to choose how it's going to appear on the 

floor plan. Now the floor plan, show on stories says, 'All relevant stories'. We could choose to restrict it 

to only a specific story. We can choose to show the outlines only or projected. So here is this outline. 

What if we did 'Projected'? Now we are seeing a more detailed shape. What if we changed this to 'Cut 

Only'? This happens to be up at the 4' level; that is why we are seeing this as 'Cut Only'. Let's say 'Show 

Projection'. Okay, that's the entire element.  I know that when I've used 'Cut Only' before with a molding 

over a door, because the cut plane was at the middle of the door rather than at the top, it didn't have 

this particular issue. [1:04:09] 

Let's temporarily change our cutting plane down to see what that does. Instead of 4', let's make it 3' 

temporarily. Ah, there we go. You can see now, because the cutting plane is below the top of that 

morph, even though the morph exists here, it's only showing the cut. This is showing this particular fill 

here because it was set to be plywood, which has that particular fill. So if I were to change this to be 

wood framing or wood trim then it's going to show as transparent. Now this here, why is that showing 

the outside? [1:04:51] 

Let's make the cut lines 'solid' instead of 'dotted dense'. In this case I want it to be solid, and now it's 

going to be showing that. So you do have some flexibility here. I had to adjust my cutting plane because 

the top of this particular morph was right at the top of the cutting plane so it didn't give me the options 

that I needed. But hopefully that gives you an idea of the flexibility of display options for the morph tool. 

I see some other comments here. I think we are going to finish up and resume in the next lesson. I will 

make some quick responses to the comments here. [1:05:35] 

Tim Ball says, "I have seen it used to create window surrounds such as stone coins." Yes, you can do 

some things on the face of the wall like that. Joe A. was asking, "Can you use the morph as a ground 

plane instead of a mesh for terrain modeling?" The answer is yes, you could. It doesn't have the ability 

to - you can convert any element, including a mesh, into a morph. And you could create a morph as the 

base that would be the ground plane. But I think that its ability to interpolate between points is going to 

be somewhat different. [1:06:21] 

You may, with the idea of creating an idea of a contour line of a uniform height might not work in a 

convenient way. I'm not sure really what benefit you would get. It's possible that it might give you some 

more flexibility. Frankly, I am not quite sure about that. Okay, Chris S. says, "Can you make a ridge from 

the top of box to form a roof?" Yes. If we go back here to that shape here and I select this and go to an 

edge, I will draw a straight line here. Let's rotate around this. You can see I am on the Y line here, so this 

is now a line. I can go in and take our editing plane vertical. Ctrl+select this, and take this point up along 

this face. [1:07:28] 

That's interesting. Now this is taking this point here. So that's an interesting thing. Let's see if I can get 

this whole edge. I will go to the middle of this and do Command+D and take this up. Now I have that 



 
 

  Best Practices Course – Week 17 Part 9-A – © copyright 2014 by Eric Bobrow 
 
 

selected and I am moving the entire edge up there. So you can see how we can create that. what I did 

was selected the edge here using sub item selection, the Shift+Ctrl, then I hit Command+D or Ctrl+D to 

drag, having made my editing plane be this vertical plane here rather than the default editing plane. 

Then I was able to drag that up. [1:08:26] 

Craig B. asked, "How would you accurately position the openings, say the top at 7' above the base?" I 

am not quite sure when you say "the opening" what you are referring to. It's something from 15 minutes 

ago. I think you can definitely measure things along the surface, and even draw some guidelines with 

the Morph tool. We can look at that again later. I see some other comments from Dave N. and Carol W. 

saying "Thanks." Lynn P. says, "Can the morph follow a curved wall with an arc as well?" Let's look at 

that next time and some more complex modeling, because we can definitely do some more curves in 

this. And we also have the option for converting elements into morphs. [1:09:19] 

If I were to select this wall here - I will leave you with this - I go to the Design menu, Convert Selection to 

Morph. It warns me that it's going to convert these things into a morph. The original as well as the 

dimensions will be deleted. It now looks like a wall with doors and windows, and if I go to the floor plan, 

it looks sort of similar. But what is it? It's a morph. So therefore, this is not a window anymore or a door. 

It looks like it, but it's not, so it wouldn't show up in the window or door schedule. So you have to use 

this sparingly. But it does give you the option to go here and do something that we all probably wanted 

to do at some point, which is to take the top of a wall up.  [1:10:07] 

Let's see, I am going to take my editing plane along this face here and then go and select this edge and 

this one. Then I will drag from here up. So what have I done? I made this wall have a slanted top. 

However, the tradeoff is, this is no longer a wall, it's a morph. So for certain quick modeling things, it's 

ideal. But for construction documents, it's going to cause some issues. So this will be a good point to 

finish up in that it shows us that there are some possibilities here that can get gnarly, but can provide 

tremendous power when you want to model things more freely. [1:11:14] 

I want to thank you all for attending today. I am sure there will be questions, and I look forward to 

reading your questions and comments on the page down below the recording. This has been Eric 

Bobrow, thanks for watching.  

[END OF AUDIO 1:11:32] 


